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MYOB – Windows Networking Tips & Techniques 
 
This document is a compilation of various support documents published by MYOB, technical resources 
produced by Certified MYOB Consultants; and other resources supporting the MYOB community around 
the world. We are pleased to acknowledge their valuable contributions.  
 
While the focus is primarily on the Windows platform, many of the tips and techniques are applicable to 
the Macintosh platform. 
 
We have attempted to edit / update the information to reflect, as much as possible, the latest operating 
systems and techniques.  
 
 

DISCLAIMER 
 
While the authors have taken great care to ensure the completeness and accuracy, this document is 
provided ‘as is’. The authors provide no warranty whatsoever as to the accuracy of the information 
contained herein. The authors do not accept any liability for damages arising from implementation of any 
of the recommendations provided. Technology issues can be quite complex, and continue to evolve daily. 
 
End-users are encouraged to utilize the services of certified technicians in the implementation and 
management of their computer systems.  
 
 
The authors would very much appreciate any comments or contributions that you may wish to provide, 
which will clarify or expand upon this documentation. Please contact the author at 
http://www.freshinsight.com. 
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Operating Systems 
Generally, we recommend that you avoid mixing operating systems as much as possible, and resist the 
temptation to use the very latest operating systems, particularly during their initial iterations.  
 
Operating Systems, such as Windows, are extremely complex, and are always geared to maximize 
performance on the latest hardware systems available. At the same time, they attempt to maintain 
‘backward compatibility’. Given the immense array of manufacturers and software vendors, and 
combinations of their products, it is almost impossible to trap all potential problems in beta testing. 
Therefore, significant problems / conflicts always arise during the first year or so following the release of 
new operating systems. Small and medium sized enterprises cannot afford to be on the ‘bleeding edge’, 
by adopting new operating systems prematurely. We strongly recommend that you avoid new 
operating systems for the first year, or at least until the first or second ‘Service Pack’ has been 
released. ‘Service Packs’ are updates which address any bugs or deficiencies that have been identified to 
date, and are available free from the Microsoft web-site. 
 
Recently, Microsoft has tended to release ‘home versions’ of operating systems, such as Windows Me, 
and Windows XP – Home Edition. Experience has proven that these systems tend to be very strong in 
handling media applications (sound, video, etc); but they are generally less configurable, and they are 
critically weak when it comes to stability and security, particularly on ‘domainless’ networks. In fact, 
the problems are so severe that many software vendors refuse to support multi-user business applications 
on these systems. We strongly recommend that businesses do not use ‘home’ versions of Windows 
Operating System. 
 
For proven performance, stability and security, we recommend Windows 2000 Professional Edition 
as the enterprise-wide desktop operating system. For sophisticated enterprises with more than two to 
three workstations, larger transaction volumes, and/or high-speed internet connections, we strongly 
recommend Windows 2000 Server, ‘Advanced’ or ‘Small Business Edition’. Businesses with large 
investments in legacy workstations running Windows 98SE, the most cost-efficient solution may be 
Windows 2000 Server with Terminal Services. 
 

Terminal Services allow you to extend the utility of legacy workstations by converting them to 
‘terminals’. As ‘terminals’ they merely access the server, where all programs reside, and where 
all processing is done. The minimum workstation hardware requirements to run terminal services 
are significantly less than would be required to run current office applications. Properly 
implemented, terminal services will provide multi-user performance approaching single-user 
performance on the server. In addition, because all applications are run on the server, 
maintenance is restricted to a single computer, and all software installations/updates are 
performed only on the server, and are instantly available to all workstations.  
 
Additional benefits of Windows 2000 Server are the included applications to securely manage 
internet connectivity, email applications and shared faxing capabilities.. 

 
 
 
 
 
When selecting an Operating System, please note that ‘minimum system requirements’ are significantly 
understated where performance is an issue. ‘Minimum system requirements’ are those which allow the 
OS to load and function; these requirements do not ensure acceptable performance. 
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Generally, for networks with more than two or three workstations, we recommend that businesses employ 
the services of Microsoft Certified technicians who are fully engaged in the area, and who maintain their 
knowledge through continuous professional development.  
 
Sure signs that you are not getting the level of professional support that you deserve are: 
 

• Your technician embraces new systems too quickly, ignoring the risks that we have outlined 
above. 
 

• Your technician does not revisit critical areas on a regular basis. These would certainly include: 
o Preventative Maintenance: 

 
When was your hard drive last defragmented? When was your Operating System last 
updated? When was the computer last cleaned (aside from power fluctuations, heat is the 
greatest threat to your hardware components.. removing the covers and vacuuming out 
the computer annually, or more often under severe conditions, can significantly extend 
the life of all components) ? 
 
Has your technician even discussed these issues with you? 
 

o Anti-Virus Software / Internet Security Issues:  
 
The proliferation of viruses, particularly as email attachments, has accelerated at an 
amazing pace these past few years. Do you know when your email client was last 
updated? On a network, when was the central email management program last updated? 
Is your anti-virus software configured so that it will automatically check all in-coming 
email before it goes to each workstation? Is it configured to automatically download 
current virus definitions at least weekly? Have you maintained your subscriptions for 
such updates, as appropriate? Does the anti-virus software automatically protect every 
workstation on your network, including new ones as they are added? Does it 
automatically check every diskette and CD as they are installed into any workstation? 
Did you know that some viruses will automatically execute if the email is displayed in a 
preview pane? Has your technician discussed ways to turn off the preview pane and 
manage such risks? 
 

o Microsoft Office and Internet Explorer Applications:  
 
Because these applications have become so ubiquitous, and because they are so tightly 
integrated to the operating system, they are often exploited by hackers and viruses. 
Microsoft constantly releases ‘service packs’, ‘patches’ and other updates to minimize 
your exposure. When did your technician last update these applications? Were the 
updates installed on every workstation? 
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Anti-Virus Software / Network Security (Firewalls) 
As discussed above, the proliferation of computer viruses dictates that businesses implement a world-class anti-virus 
solution. Symantec’s Norton Anti-Virus and MacAfee Anti-Virus are two of the most recommended solutions. Both 
companies are constantly updating their software and virus definitions on a daily basis. Available services include 
automatic scheduled downloads of updates, and direct notification (by email) of special hazards as they arise. 
 
Minimum Anti-Virus Strategy includes: 

• Legal copy of software, properly installed 
• Coverage of every single workstation 
• Current subscription to program and virus definition updates 

Because most businesses utilize ‘always-open’ internet connections, such as cable or ADSL, which use (relatively) 
fixed IP addresses, they are vulnerable to attacks through their internet connections. For this reason, it is absolutely 
necessary that networks be fully secured by adequate firewall protection. While there are software solutions (Norton, 
Zone Alarm, and others)1, we strongly recommend a hardware-based firewall solution, such as Linksys or 
Symantec true firewall solution (van (100). The Linksys router is actually a NAT Firewall not a true Firewall... it 
merely ‘masks’ IP addresses... it does not discriminate as to what information is transferred to or from the Internet.. 
As an additional benefit, the Norton solution is fully integrated with their Anti-virus software, and will prevent 
‘denial of service’ attacks from outside. 

Setting it Up Properly 
Hardware Minimum Recommendations 
The following minimum requirements exceed those specified by software publishers, and are intended to 
assure acceptable performance within reasonable considerations. 

CPU (Central Processor Unit) 
Generally, we recommend that businesses purchase the latest technology that they can afford. There are 
three caveats: 
 

• Just like operating systems, newly released CPUs tend to be somewhat problematic, and therefore 
should not be embraced too readily. In addition, you always pay a premium for new features 
which, for the most part, are not required by most businesses. We recommend that most 
businesses restrict purchases to ‘second generation’ technologies, such as a Pentium III instead of 
the current Pentium IV. 
 

• Stick with brand-name computers, such as IBM, Dell, HP or Compaq, and select models designed 
for business, rather than home use; and purchase from authorized dealers only. If the vendor does 
not inquire as to the type of applications and environment in which you will be using the 
computer, you are probably dealing with the wrong vendor. 
 

• Be sure to purchase ‘business-strength’ operating system. (See comments above regarding 
operating systems). 

                                                      
1 Be aware that Software firewalls create issues within a Network situation.  A Software firewall, when placed in a 
network, should be placed in on the proxying server. It must be configured carefully to prevent internet access into 
the LAN, while still permitting the Internal LAN to function properly.  A software Firewall is not recommended 
unless it is a single user workstation; not a network 
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Memory 

Host Computer 
The ‘host’ is the computer on which your data file is located.  
We recommend 128 – 256K RAM, or 256-512K RAM if for larger networks, or where multiple 
applications are being hosted on the same computer. For servers hosting terminal services, we 
recommend 512-1024K RAM, depending upon the number of concurrent users and applications.  

Workstations 
‘Workstations’ are the other computers on which MYOB and other applications (Word, Excel) 
have been installed. The applications are accessed and run ‘locally’, while the data file is 
accessed over the network...  

We recommend 64-128 K RAM. 

Terminals 
‘Terminals’ are workstations configured to access applications and data files which are not only 
hosted, but actually run on the server. See comments of Terminal Services earlier. 

We recommend 32-64 K RAM. 

What type of RAM should I buy? 
Ensure that you purchase RAM that is certified by the manufacturer or from a vendor such as SIMPLY or 
Kingston which are certified for OEM replacement.  Most issues such as Fatal OE or Page faults can be 
traced 90% of the time to RAM that is faulty or improperly matched to current installed RAM leading to 
timing issues that must be adjusted through BIOS 

NIC 
Network Interface Cards should operate at 100 MBps, and support full duplexing. Where possible, avoid mixing 
different brands, and standardize on leading hardware manufacturers. Be prepared to pay a premium to ensure 
premium performance and reliability. Leaders historically have included 3-Com and Intel. These past two years, 
Linksys products have proven extremely reliable. Your technician may recommend other brands which satisfy the 
minimal recommendations we have outlined. Best results are achieved with NICs that support parallel processing. 
This ensures that these cards contain onboard processors. 

NIC Drivers 
‘Drivers’ are the software that allows your computer to ‘manage’ a particular network card. 
Leading manufacturers are constantly updating their drivers to ensure stability and security. 
Given the rapid evolution of operating systems, and combinations of hardware components, there 
may be frequent updates to the drivers. In fact, it should not be assumed that the drivers which 
come with your NICs are the most recent. We strongly recommend that installers visit the 
manufacturer’s website to ensure that only the latest drivers are used. 
 
• Professional technicians will tend to ‘standardize’ on their choice of NICs, and ensure that 

they have, and maintain, the latest drivers for their clients. 
 

• CAUTION: Many NIC Drivers include optional facilities which will conserve energy by 
‘powering down’ the NICs. Energy saving facilities must be fully disabled on all NICs. 
MYOB requires unrestricted access to every active workstation. Energy saving facilities can 
lead to degraded network performance, error messages and data-file corruption. 
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Realtec NIC – Caution 
Realtec NICs have a notorious reputation, and are definitely not recommended. Even with current 
drivers, consultants have reported frequent problems, including data file corruptions. Realtec 
cards are amongst the least expensive available, and for this reason have been adopted by many 
‘white box’ manufacturers looking to save nickels on cheap computer systems. Even installing 
the latest drivers has failed to resolve problems. We have had two situations where network 
problems were completely eliminated by replacing Realtec NICs with Linksys NICs. The 
differenced between ‘economy’ NICs, and proven technology is only $10 to $15 per workstation, 
an ‘economy’ that businesses simply cannot afford to risk. 

Switch (Not a Hub) 
If you have an exiting network that is two or more years old, chances are that you are using a hub. A hub 
is a ‘central’ device to which each workstation is connected by a cable running from the NIC. When a 
workstation sends a message to the hub, the hub duplicates the message and distributes it on to every 
other computer on the network. By today’s standards, this technology is extremely slow and error prone 
due to the increased traffic on the network. The total throughput capacity, typically 10 MBps, is shared 
amongst the workstations. As you add workstations, then, you must accept degraded performance. 
 
A switch will provide performance significantly greater than a hub. A switch redirects data only to those 
workstations to which it is directed.  This means reduced network traffic. In addition, a switch maintains 
full network throughput, typically 100 MBps, to every single workstation. As you add workstations, then, 
you do not have to accept degradation in performance. Properly implemented in combination with quality 
NICs, a managed switch may deliver speeds up to 200 MBps. 
 
Given the performance boost provided by a switch, upgrading from a hub may be the smallest investment 
to provide the greatest benefit possible. A five port switch, for instance, typically retails for only $50.00 
to $75.00, a fraction of what you probably paid for your hub. Upgrade today! 

Cabling 
Recommended cable is Cat 5. We recommend that most businesses purchase certified pre-made cables in 
lengths to meet their requirements. For larger networks, or where longer runs (lengths) are required, we 
strongly recommend that you engage the services of professional installers who have the experience and 
technology to install and certify the cabling. Certification, in writing, is an important consideration, and 
well worth the $75.00 to $100.00 per run which you may expect to spend. Cat 5 cables are all labeled as 
such... when checking your cables, be sure to check all, including ‘patch cords’ and ‘in-wall’ cables. 

Network Upgrade Considerations – Cabling 
When you upgrade an existing network by changing NICs, switches, or adding faster 
workstations, you will find that newer technologies are less tolerant of cabling deficiencies. A 
network that functioned OK before the upgrade, may fail unexpectedly. When making changes 
that impact ‘legacy’ network components, have the network tested under the new load before 
proceeding. 
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Installation of MYOB 
MYOB is a peer-to-peer product, not a client-server product. This means that the program must be 
installed and run locally on each workstation, with the data file residing solely on the ‘host’ computer.  

Included Resources 
Your installation CD includes current versions of other programs, which are required to support MYOB. 
These resources should be installed before installing MYOB: 
 

• Library – This is a folder containing copies of the Certified Consultant’s Directory, and MYOB 
Reference Manuals. These may be displayed or printed using the Adobe Acrobat Reader. 

• Adobe Acrobat Reader – Used to display, navigate, and print manuals and help files. 
• Internet Explorer – Used to display and navigate your MYOB Manuals and Help Files. 
• Quick Time – Used in generation of ‘PDF’ copies of Invoices, Purchase Orders or Reports from 

within MYOB. Quick Time is required to ensure proper handling of graphics and fonts. 
* PDF: ‘portable document format’ is a standard developed by Adobe for the exchange of 
documents over the internet. Those who are ‘receiving’ the documents do not have to have the 
program that created the document (such as Word, Excel, or MYOB) to open and read the 
document. All they need is ‘Adobe Acrobat Reader’, which is available free, and will work on all 
computer platforms (For instance, an invoice prepared on a Windows computer can be read on a 
Macintosh computer). 

Default Location / Hard Drive Space / Virtual Memory 
Normally, we would recommend that you accept the default installation, typically C:\PlusXX, where 
‘XX’ indicates the version being installed. 
 
Following installation, be sure to take time to ensure adequate hard drive space, and memory allocation to 
ensure acceptable performance. Recommended requirements are covered in detail on page 17. 
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Location of Data File – Workstation or Server 
Ideally, on a peer-to-peer network, the data file should be located on the most robust workstation, where 
the heaviest transaction load will be handled.  

When is a Server a Server? 
For larger networks, you may choose to locate the data file(s) on a server.  
 

Some may be tempted to ‘host’ data files on a robust computer running a ‘standard’ version of 
Windows. While this approach may simplify the ‘sharing’ of data, there is rarely any advantage 
over ‘hosting’ the data on a robust workstation. In fact, there may be degradation because of 
increased network traffic.  

 
A server differs from workstations in four key areas: 

• The hardware components are much more reliable, and fault tolerant, than those found in 
‘standard’ computers. Even the memory is specially designed to meet the demands of a true 
server environment.  

• Redundancy is built in: 
o Special hardware (RAID Controllers) may be employed to support multiple hard drives, 

where the data on one drive is ‘mirrored’ on the other. If one drive fails, the server 
automatically switches to the other drive, and everything continues to function with no 
interruption or data loss. The server will automatically alert the Administrator of the 
problem. Some servers will even allow you to ‘hot swap’ a new hard drive for the failed 
one, without even shutting down the server. 

o Redundant Power Supplies may provide backup as well. 
• Operating Systems are specifically designed for Servers.  The demands for managing concurrent 

processing for multiple users, sharing data, as well as monitoring server hardware and resources, 
require an operating system specifically designed and properly implemented for each business. 
We recommend Windows 2000 Server. 

• High-level backup hardware, such as tape drives, is normally built into servers. These provide 
another level of protection because the process can be automated, and the ‘media’ can be securely 
stored off site. 
 

Network Protocols 
Protocols determine how messages are delivered across the network. The recommended ‘default’ protocol 
is TCP/IP. Legacy protocols, such as NetBEUI or NetBIOS, should be eliminated if at all possible. If you 
have to retain these to support a specific application, you may do so, with two caveats: 

• Where multiple protocols are required, TCP/IP should be the ‘default’ 
• Running multiple protocols increases network overhead, and decreases performance. For this 

reason, we strongly recommend that you avoid installing any protocols which are not absolutely 
required. 

 
Static IP address is required for each workstation. 
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Sharing & Mapping 

Sharing Resources 
‘Sharing’ is the process of identifying ‘resources’ (programs, folders, files, directories, printers) of one 
workstation, which may be accessed, or used, by another workstation on the network. 
 
Indiscriminate ‘sharing’, such as ‘sharing’ the entire hard drive(s) of every workstation, adds overhead to 
the network, and virtually ignores all security considerations.  This is the ‘laziest’ way to set up a 
network, and means that anyone, from any workstation, can potentially copy or delete any files on any 
other workstation. If your network is connected to the Internet without a firewall, then your files are also 
available to the entire world!  
 
Resources should only be ‘shared’ where there is a compelling business argument to do so, and even then, 
the sharing should be done in a way that restricts access to authorized users who must ‘log on’ to the 
network with a unique User ID and Password. Users should be given privileges appropriate to their 
experience and responsibility. The following illustration reflects how ‘Groups’ may be used to manage 
levels of access for users under Windows 2000 Professional: 
 

 
 

As mentioned before, your ability to manage the risks of sharing resources is directly proportional to the 
investment you are prepared to make in the choice and implementation of the operating system. 
 
For exact procedures to ‘share’ resources under the various Windows Operating Systems; search for 
‘sharing’, in your MYOB Help Files.  
 
 



MYOB – Windows Networking Tips and Tricks 
 

© Dick Hope & Associates  Page 11 

Mapping Network Shares 

After file sharing is set up on the computer on which your Plus Company file resides, you need to set up 
each of the other computers on the network so they're able to access the shared folder. This process is 
usually known as mapping, and it needs to occur only on the computers that are not storing your Plus 
company file. Mapping sets up a workstation to handle the shared folder transparently, as if it were 
another drive on the workstation. MYOB will not function properly if the shared folders are not properly 
mapped on each workstation. 

Follow the steps below on all of your network's Windows computers that are not storing your Plus 
company file. (These instructions apply to all versions of Windows.) 

1. From the Start menu, choose Programs, and then choose Windows Explorer (or Windows NT 
Explorer, if you're using Windows NT). When the Explorer window appears, choose Map Network 
Drive from the Tools menu. The Map Network Drive window appears.  

2. From the Drive list, choose the drive letter you want to assign to the folder on the computer that's 
storing your Plus company file. The drive letter that appears automatically in the list is the first 
available letter.  

Note: Every computer doesn't need to be assigned the same network drive letter  
 
If each computer on your network uses a different drive letter to map to the computer on which your Plus 
company file is stored, that's OK. The drive letter is used only for identification purposes on each computer.  
 
For consistency, we normally select drive letter “M” (for MYOB) on all workstations. This makes it easier 
to recognize the ‘MYOB’ share. In addition, this approach provides a ‘consistency’ that helps to implement and 
maintain mapping on multiple workstations. 
 

3. In the Path field (or the Folder field, if you're using Windows 2000 Professional), enter the path name 
for the computer and the Plus folder to which you want to map. To do this, enter two backward 
slashes (\\) followed by the computer name, another backward slash, and the name of the folder. For 
example, if the Plus company file is stored in a folder called Plus11 on a computer named 
COMPUTER, you'd enter \\COMPUTER\Plus11 in the Path field.  
Tip: You may find it easier, and more intuitive, to use the ‘Browse’ button to locate the shared 
folder which you wish to map. 

4. Mark the box labeled Reconnect at Logon to ensure that this computer is always mapped to the Plus 
folder.  

5. Click OK, or Finish, to close the Map Network Drive window. If you've set up a password for the 
folder, a message will appear, asking you to enter the password. Make your entry and click OK.  

That's it! This computer is now mapped to the folder containing your Plus company file. Look at the left 
pane of the Windows Explorer window; you'll notice that the new drive letter has been mapped to the 
Plus folder. Remember to perform these steps for each of the computers that need to access the company 
file. 
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Small network overview 
Using Windows 2000, there are numerous ways to connect computers or create a network. The most 
common models are peer-to-peer networks and server-based networks. Each approach is different and has 
distinct capabilities. The type of network you choose is determined by several factors, including the 
number of computers that you want to connect, the level of security you require, and the needs of the 
users who utilize network resources. 

Peer-to-peer networking 
A peer-to-peer network, also called a workgroup, is commonly used for home and small business 
networks. In this model, computers directly communicate with each other and do not require a server to 
manage network resources and permissions. Each workstation manages it own security.  This means that 
the user ID and their respective password must be entered on every workstation to ensure security 
consistency across the network. 
 
In general, a peer-to-peer network is most appropriate for arrangements where there are less than ten 
computers located in the same general area. It is less expensive and easier to maintain, but it is also less 
secure, has added administrative headaches, and fewer features than a server-based model. The computers 
in a workgroup are considered peers because they are all equal and share resources among each other 
without requiring a server. Each user determines which data on their computer will be shared to the 
network. Sharing common resources allows users to print from a single printer, access information in 
shared folders, and work on a single file without transferring it to a floppy disk. 

In order to establish a peer-to-peer network, you must ensure that all of the necessary hardware, settings, 
protocols, and services are configured properly. This includes: 

• Installing a network adapter, also called a Network Interface Card (NIC), in each computer that 
you want to include in the network.  

• Connecting the computers. You will need to decide which design layout, or topology, will work 
best for your network. Some common topologies are bus, star, and ring. The topology you choose 
will determine what type of cabling and connectors you will need.  

• Installing a network service (the software that allows you to connect to other computers on the 
network).  

• Installing the correct network protocol. Each computer must be using a compatible network 
protocol, such as TCP/IP, NetBEUI2 or IPX/SPX. 3. 

                                                      
2 NetBeui simplest protocol but in the Internet empowered network it is not compatible nor is it efficient when using 
more than 10 users  ( Excessive broadcasting) 
 
3 IPX NOVELL based protocol but in the Internet empowered network. 
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Client/Server networking 

Larger businesses or those with more complex networking needs rely on a server-based network. In a 
client/server model, computer tasks are split between a stand-alone personal computer, which acts as the 
client (or workstation), and a server which maintains the security lists and bears the load of authentication 
and File data distribution.  

The server can be a personal computer, a minicomputer, or a mainframe. The server computer stores files 
for users in a central location and provides access to other network resources, such as printers, CD-ROM 
drives, and software. The server also provides data management, information sharing, network 
administration, and security features. 

The server-based network has become the standard model for networking, primarily because it provides 
reliable management of network resources and a common security database. This model can support 
hundreds of users, but is managed by a central group of administrators who oversee the network operation 
and ensure that security is maintained. Client users rarely perform work on the server computer. 

Setting up a client/server network requires more resources than a peer-to-peer network, and an 
understanding of correct implementation of server software and usage. This will ensure that all of the 
necessary hardware, protocols, settings, and services are configured properly, and you will have 
additional resource requirements, including: 

• One or more computers to be used solely as network servers. A large network may have more 
than one server, depending on the number of users, volume of traffic, number of peripherals, and 
so on. For example, you might find a print server, a communications server, and a database server 
all on the same network.  
 

• A trained administrator's staff to oversee network operations. 

Workstation Preferences 
As discussed in the manual, Introductory MYOB, Setting It Up Properly, there are a number of 
considerations in setting your MYOB Preferences. Many of these preferences are ‘System-Wide’, in that 
the setting will be applied without exception to all workstations, while others are workstation specific. In 
a multi-user environment it is important that you ensure proper settings on each workstation. 
 
Review workstation preferences by opening your MYOB data file, and then go to Setup > Preferences. 
For optimal performance, ensure that the following preferences are de-selected as indicated below: 

System Tab 

 
This preference, when selected, will force the update of displayed information on every active 
workstation, following every single workstation. This adds considerable network overhead for no 
significant benefit. Note that this preference is not ‘System-wide’ which means that it must be set 
correctly on each workstation. 

Banking Tab 

 



MYOB – Windows Networking Tips and Tricks 
 

© Dick Hope & Associates  Page 14 

 
 

Sales Tab 

 

Purchases Tab 

 
 

If you have been using MYOB for some time, and the ‘Contact Log’ preferences had been selected, then 
MYOB will have added a one-line entry into the log-file attached to cards in your data file. In most cases, 
this information is redundant, and tends to ‘bloat’ the data file, and impairs network performance.  
 
Redundant log-file entries may be purged to revitalize your data file. Exact procedures are outlined in 
your MYOB Help Files, and in the manual, Advanced MYOB – Period End Procedures. 

Maintenance 
Just like a finely tuned automobile, your MYOB data file, and your computer, both require regular 
inspection and maintenance to ensure a ‘safe trip’. The following tips are minimal, but critical, 
recommendations. 

Verification of Data File 
Verification of your data file is a process whereby MYOB will ‘exercise’ your data file to ensure data file 
integrity. By installation default, MYOB will prompt you to verify your data upon opening, and upon 
exiting your data file. This is a critical process to ensure a healthy data file. As the data file grows, you 
will notice that it will take longer to complete the verification. The longer it takes to complete 
verification, the more important it is that you take time. The time between verifications should be directly 
proportional to the amount of data you are willing to loose. We recommend daily verification of data. 
 
You can re-visit your MYOB Preferences (Setup > Preferences > Security) to ensure that MYOB prompts 
you to do a verification upon opening, or immediately prior to backing up your data file. In addition, you 
may select ‘File > Verify Data File’ at any time. 
 
At minimum, the data file must be verified (and backed up) daily. 

Optimization of Data File 
Optimization, to your MYOB data file, is what ‘de-fragmentation’ is to your hard drive. As you edit (or 
delete) a transaction, the ‘space’ formerly occupied by the data, is not recovered automatically. Over time, 
this space can come to represent as much as 70 to 80% of the data file, with a significant degradation in 
both performance and security.  
 
To optimize your data file, everyone must sign out of MYOB first. Then, go to your MYOB program 
folder and run the ‘MYOB Optimization Assistant’. 
 
At minimum, the data file must be optimized (and backed up) monthly. Very large data files may 
require optimization on a weekly or even daily basis.  
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Backup Protocols 
Backup Protocols will vary from system-to-system, but the base requirements remain the same: 
 

1. Recognize that ‘backing up’ from within MYOB includes only the data file. Customized forms, 
reports, etc. and not embedded in the data file. They reside in special folders within your MYOB 
installation folder on your hard drive. For this reason, you may wish to utilize a backup program 
which allows you to include multiple files, and which includes facilities to automatically 
compress and verify backups. 

2. Backups should be to some form of removable media, such as ZIP disks, CDR media, or tapes. 
3. Backup media should be ‘rotated’ and ‘verified’ on a fixed rotation: 

• Rotation of Backups: 
o Use a minimum of five ‘media’, labeled and utilized as follows: 

 Media #1 – Monday / Wednesday / Friday 
 Media #2 – Tuesday / Thursday / Saturday 

• These two media are used alternately, so that you will always have a 
backup as of the close of business ‘last night’ and ‘the night before’. 

• These two media may be stored ‘on site’, but away from the 
computer. They are intended to provide recovery protection in the 
event that your computer failed. 

 Media #3 – Week #1 
 Media #4 – Week #2 
 Media #5 – Week #3 

• These three media are used in rotation, so that you will always have 
backups as at the close of business at each of the most recent three 
weekends. 

• These three media should always be stored ‘off site’, providing 
additional protection in the event that your office is lost to theft or 
some other disaster. 

• Verification of Backups: 
o Both backup software, and media, are known to fail from time-to-time. What would 

happen to your business if you lost your MYOB data completely?  
o We recommend that you periodically verify the backups by restoring a backup to a 

different computer, and verifying the recovered data file. 
• Responsibility for Backups is a Management Responsibility: 

o While the ‘function’ of performing backups may be delegated to an employee, the 
responsibility remains with management. 

• Backup Facilities should remain in the hands of the person(s) responsible for your MYOB 
accounting. This will ensure timely backups, and in-house comfort with the backup 
procedures. Experience has shown that backups made by ‘system administrators’ tend to be 
more casual and less reliable... they simply do not recognize the either the value of the data, 
or the costs of lost data. 
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Hard Drive Maintenance 
 

• De-fragmenting your Hard Drive 
De-fragmenting is the process of rewriting parts of a file to contiguous sectors on a hard disk to 
increase the speed of access and retrieval. When files are updated, the computer tends to save these 
updates on the largest continuous space on the hard disk, which is often on a different sector than the 
other parts of the file. When files are thus fragmented, the computer must search the hard disk each 
time the file is opened to find all of the file's parts, which can significantly slow down response time. 
Fragmentation is also a consequence of adding and removing programs.  

Using Disk Defragmenter 
Disk Defragmenter rearranges files, programs, and unused space on your computer's hard disk, so 
that programs run faster and files open more quickly. Disk Defragmenter does not affect anything 
that you see on the screen, such as files in My Documents or shortcuts on the Programs menu. 
 
The Disk Defragmenter Program is one of many ‘System Tools’; and is accessed as follows: 

o Click Start, point to Programs, point to Accessories, point to System Tools, and then 
click the appropriate icon.  

o For information about using Disk Defragmenter, click the Action menu in Disk 
Defragmenter, and then click Help.  

 
We strongly recommend de-fragmenting your hard drive on a regular basis, say quarterly. Routinely, 
we set up a desk-top shortcut to facilitate monthly de-fragmentation. 

• Free Space on your Hard Drive 
Free space must be maintained as a minimum percentage of your total hard drive. This space is 
required to accommodate temporary files created by various programs. Like many programs, MYOB 
will use this space to store reports before they are displayed or printed. In addition, MYOB will verify 
available space before allowing you to open your data file, and add transactions. 
 
For further considerations, see page 17. 
 

Upgrading/Expanding your Network 
Recognize that the stability and speed of your network will only be as good as the weakest link. When 
you ‘crank up’ your network by adding components (computers, network cards, etc.) or more current 
Operating Systems, the rest of the network must be capable or handling traffic at that speed. For example, 
the cabling and connectors that you installed 3, 4 or 5 years ago may no longer be adequate due to 
changing specifications, deterioration, drivers, etc.  
 
Proper Network Management includes thorough documentation of NICS and Drivers… recommend 
standardization. 
 
All we’re suggesting is that you thoroughly test the network after upgrading to assure performance under 
load. Good switches, network cards, cabling combined with proper configuration of caching, 
opportunistic file locking, etc. are absolutely required to ensure network stability. 
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Error Messages 

General Protection Faults and Illegal Operations; Invalid Page Faults 
These errors indicate a defect in the manner in which the Windows Virtual Memory Manager is managing 
the allocation of memory. Physical Memory may, from time-to-time, be insufficient to manage the 
application(s) or file(s) you are accessing. Under these circumstances, the VMM will swap pages 
(segments) of memory to your hard drive, and read them back into memory as the need arises. Errors arise 
when Windows cannot find the data due to insufficient RAM or Hard Drive space, or when corruptions 
occur due to conflicts, such as may arise between two programs trying to utilize the same space.  
 
To put it another way, A General Protection fault occurs when a Windows application writes to a memory 
space where it doesn’t have access.  This corrupts any other code that already occupies that memory 
space. Broadly speaking, General Protection Faults can occur when a MYOB accounting product requests 
additional memory, for example when printing a report, or loading a new list.  The Windows system 
provides memory to the application that it considers to be available. If this memory is in use by another 
program, the MYOB accounting product cannot continue and advises Windows, which displays a General 
Protection Fault message and closes down the program. 
 
Due to the nature of the problem it can be difficult to identify the cause, which might be a non-standard 
item, such as a display driver or memory manager installed in the system, or a TSR program loaded 
automatically at start up. The error itself will not cause any harm.  The problem is that Windows forces 
you out of your program, so anything not saved at that time is lost.  In any case, it indicates a problem 
with your system. 
 
Fatal Operations are usually the fault of accessing memory that used to contain data for the application 
only to find it missing or corrupt.  This is usually caused by memory that is malfunctioning or not timed 
correctly to other RAM that is in the system.  If this occurs shortly after adding additional RAM, replace 
the new RAM, or replace the entire RAM in the system, with RAM of the same type 
 
Windows 9x, NT & 2000 allow swap files to expand and contract according to demand. This is called 
dynamic paging. While this sounds like a great idea, it can cause significant problems. This approach can 
cause excessive fragmentation of the hard drive, particularly on larger drives. This fragmentation 
demands more reads/writes, and ultimately degrades performance. We strongly recommend that you fix 
the size of the SWAP file to optimize the operation of windows, and select a size that is 1.5 times the 
existing memory.  If you start running into “running out of memory errors” then purchase more ram and 
adjust the size of the swap file accordingly.  Increasing the swap file to an excessive size will fix the 
problem short term only to slow the computer down and to place more risk to data that is being used in 
the current application.   
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What should I do when a General Protection fault occurs? 

System Tips 
1. Many GPFs are resolved by restarting the computer.  

Turn off the computer and Restart. Be sure to wait 10 seconds before restarting, as this may be caused 
by buy a glitch in memory that can only be removed by a complete power shutdown 
. 

2. Delete temporary files (~.tmp) in your TEMP folder. In Windows 95/8 this is normally the 
c:\windows\temp folder. 
 

3. Defragment your hard disk. In Windows 95/8 go to the Start button > Programs > Accessories > 
System Tools > Defragment Hard Disk… this will help in swap file access.  
 

4. Ensure you have enough hard disk space and RAM. Running low on memory is one common cause 
of General Protection Faults. This problem is very common with Windows 98. 
 

5. Try changing the color settings (e.g. from 32 Bit to 256 colors). Try changing the video driver to the 
standard VGA option 
 

6. Remove Background Images which consume memory; and disable screen savers which also consume 
memory and precious CPU power. 
 

7. Start in Safe mode in Windows 95/8 to see if there is a program or driver that is conflicting with 
MYOB. To start in Safe mode, press F8 while your computer is booting. If you do not have a general 
protection fault in Safe mode, reboot the computer; disable the programs that start up automatically 
and try running your MYOB accounting product.  

To temporarily shut down programs that start automatically: 

In Win 95/8 press Ctrl+Alt+Del and then click End Task on one program in the list, (except Explorer). 
Try running your MYOB accounting product. If the problem still occurs, repeat this step for the other 
programs. 

To permanently disable programs from starting automatically 

In Win 95/8 right-click the Start button and select Explore. Go to the Start up folder and delete the 
shortcuts appearing. If this resolves the problem, do not use the program that has been disabled while 
your MYOB accounting product is running and search the Internet for updates to your hardware drivers 
and software. 

1. Check that a printer driver is set as default in the Printers Control Panel, as an absence of this might 
result in General Protection Faults (regardless of whether there is a printer attached). 

2. If you are running a screen saver, remove this at least until you are sure it is not the cause of the 
problem. 

3. If the System tray shows icons (in the bottom right hand corner of the Windows 95/8 desktop), right-
click them and close them. 

4. Reinstall Windows as this often resolves the problem. 
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MYOB Tips 

1. Reinstall your MYOB accounting product (make sure you have a backup of your data file and any 
customized forms first). 
 

2. If the error is occurring when you print a customized invoice or statement, try using the ‘pre-printed’ 
option.  If it no longer occurs, the problem is probably associated with your customizing - particularly 
graphics pasted on the form.  MYOB accounting software requires graphics to be in a bitmap (.bmp) 
format.  The Paintbrush program can convert graphics to this format.  If there are no graphics, re-
customize the form. 
 

3. Check the fonts being used for reports and forms (default fonts, and in any customized report/form).  
Try changing them to Arial, at least until the cause is known. Fonts from other programs (particularly 
CorelDraw) may well conflict with MYOB accounting software. 
 

4. If the GPF occurs when trying to print or display a report, you should reinstall the printer software 
provided by the supplier, or alternatively on the Windows CD or Manufacturer's website. Always 
ensure that you are using the latest drivers available. 
 

5. Check to see if the problem occurs in Widgets (the sample data file).  If the problem does not occur, 
you might have a corruption in the data file. Contact MYOB Technical Support for more information 
on file corruptions and repairs. 
 

6. Delete the myob.ini file from the c:\Windows folder. This file will be recreated when you restart your 
MYOB accounting program. 

Recommendations: 
1. Maximize RAM: 

• Increased RAM will improve chances of program running in memory, rather than relying on 
swaps. Swapping is always slower than RAM. 

• Memory is relatively cheap today, and newer computers, operating systems, and programs 
increasingly demand more memory for acceptable performance. Today, we recommend 256-
512K RAM for the ‘Host’ Computer (the computer which is ‘hosting’ the data file); and 128-
256K RAM for each workstation. This is double what we would have recommended one year 
ago. 

• Where possible, use a single RAM module as this minimizes the possibility of mismatched 
RAM. 

2. Create a FIXED PAGEFILE. 
• Windows 2000 recommends minimal paging file size equivalent to 1.5 times the size of 

physical RAM, but also recommends that you might increase size if you are frequently using 
programs that require a lot of memory. 

• We recommend a fixed pagefile at least 2.5 times your physical RAM (or the recommended 
size under ‘Total paging file size for all drives, whichever is larger). You can ‘fix’ the size of 
your pagefile by setting the minimum and maximum size the same.  
NOTE: Because this approach may leave more data in the swap file during a system crash, 
greater corruption may result. Be sure to implement reliable data verification, optimization 
and backup procedures. 
- Be sure to restart your computer after changing your pagefile settings, and immediately 
Defragment your hard drive(s). 
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3. Dynamic Paging 
• If you cannot implement a fixed pagefile, consider placing the swap or page file on a separate 

drive or partition, ideally where you do no other file saves. This way you can minimize 
competition for disk reads and writes; and minimize the degradation that would result from 
increased fragmentation on the drive. 

Fatal Error 1106 

What does the Fatal Report 1106 message mean? 

Programs written for Microsoft Windows, and the Apple Macintosh, store information by passing data to 
a file manager, which is not a part of the MYOB program. For example, when you ‘record’ a transaction 
in MYOB, the program takes all the information you have entered, and passes it to Windows or the 
Macintosh with a request that it be filed on the Hard Disk. It is the computer’s job to store the data 
correctly and inform the program that this operation completed successfully. 
 
Once the data is on the hard disk, it is reasonable to expect that it should stay there, intact. 
Unfortunately, computers and hard disks are not perfect. If some part of your MYOB data file becomes 
damaged, the program will report this damage as a Fatal Error 1106. 
 
If you receive this message, you should restore your data from your most recent backup, and repeat the 
operation just completed. It is important to perform the same operations on the restored data that caused 
the message to appear originally. If these operations can be performed on the restored file without the 
error appearing, move forward again from that point. If not, you should use the next most recent backup 
and repeat this process. 
 
If all else fails, damaged data can sometimes be repaired, for a fee, by the MYOB Technical Support 
team. For further information, contact a Technical Support Representative. Please note that file repair is 
NOT a priority service –your own data file backups and the Verification features (Select Verify data from 
the File menu) are your best defenses against damaged data. 

Memory in Windows - Error 114x  
If there is not enough memory available for MYOB to operate efficiently, several things may occur. 
Firstly, you are likely to notice a slowing down of the program, as the required information cannot be 
stored all at once in the available memory. 
 
If the available memory is seriously below what is required, you may experience 'Out of Memory' errors 
and messages with error numbers starting with 114 (e.g. 1143, 1144, 1149). These are nearly always 
memory related errors, and most probably indicate the computer is severely low in memory in relation to 
the size of the data file. 
The optimum amount of memory to have available to MYOB is 1.5 MB more than the size of the data 
file. It will run with less, but not at maximum speed and efficiency. If the amount free is down closer to 
the size of the data file, you are likely to receive memory errors. Check the size of the data file, add 1.5 
MB to this, then check the amount available when in Windows (all applications closed). 
 
If, you find you have too little memory, you may need to talk to your Reseller about installing more 
RAM, or consider altering your Virtual Memory settings. Virtual memory is a technique where the 
computer uses some of your hard disk's space as pretend Ram. The considerations are covered in greater 
detail, under the heading “General Protection Faults and Illegal Operations; Invalid Page Faults”, on page 
17. 
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Fatal Error 1199 

What does the Fatal Report 1199 message mean? 

When MYOB is in the process of saving your data file to the hard disk, it marks the file.  If anything goes 
wrong (for example the hard disk reports an error, or the power goes off), the file will be in an undefined 
state.  This means that the file is unusable. 
 
If this type of situation occurs, the next time you try to open the data file, MYOB will report: 

“Fatal Error 1199” 

This is a serious problem, and can only be fixed by restoring your data from your most recent backup.  
There is no other method of dealing with this situation – the data file reporting this error has become 
unusable and is irreparable. 
 

Termination Code 1250   
When running MYOB in Multi User mode there are continuous messages being sent between all 
machines that are logged into the session. When one machine records a transaction or updates the data 
file, MYOB uses the networking protocol, to send a message to the other machines to update the 
information displayed on their screens. A message is then sent back to the original machine to confirm 
that the message has been received. If the message was not successfully transported to one of the 
machines, possibly due to MYOB 'timing out' on that machine, a message such as this may appear: 
 

MYOB must terminate, a network error has occurred, Termination Code 1250, Important 
details 9998 (1147:2001:xx) Unable to send message to ZZZZ  
 

Where ZZZZ is the computer User ID name of one of the other computers on the network, where the 
Timeout occurred.  
 
If you get a Termination Code 1250 you should verify your data file to ensure that the 'Timeout' has not 
corrupted your data file. If your data file does not Verify successfully, try optimizing your data file, and 
then verify again. 
 
If you are experiencing a Termination Code 1250, there are a number of settings that you should check on 
all your machines on the network running MYOB. Some things to check are 

• Lockfiles  
• Protocols  
• Other Applications Running  
• Power Down and Screen Savers  
• Data file location  
• Hardware  
• Resources on machines  
• Slow machines and network cards  
• Distance between machines  
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To check on all machines: 

Lock files 
Whenever a user logs into MYOB a temporary Lockfile is created to store the User's name that is logged 
into that data files session. When each additional user logs into the data file, their User Id name is added 
to the Lockfile. When you log out of MYOB, your name is deleted from the Lock file and, when the last 
User logs out the Lockfile will then be erased. If you have experienced a termination or crash or have not 
closed MYOB down correctly, then your user name may not be deleted from the Lockfile, causing the 
other machines to attempt to send messages to you. 
When everyone is logged out of MYOB check to see if there are any lock files. Lock files are stored in 
the same directory as your data file. 
At the host machine go to Start>Programs>Windows Explorer and select the folder where your data 
file is stored. Check for any files called Lock0001.flk or Lock0002.flk (it could be up to Lock0010.flk) 
and delete them if all users are logged out of MYOB. 

Protocols 
When MYOB is running in Multi User mode, it relies on a protocol called TCP/IP to carry messages to 
other workstations. If TCP/IP is not installed on one of the machines, messages cannot be sent to and 
from that machine, causing MYOB to terminate.  
 
While MYOB will work with legacy protocols, such as NetBEUI, we STRONGLY recommend TCP/IP. 
 
Note that in Windows 98 you can press esc to bypass the Window login prompt.  By doing this the system 
may not be allowed to access network resources.  Even though TCPIP is configured and permissions 
seem to be set correctly.  Ensure that correct login procedures are adhered to. 
 
To check that TCP/IP is installed on Windows 95/98: 
 
Go to Start>Settings Control Panel>Network. Under Configuration you should have TCP/IP listed. 
 
The configuration tab, lists all the adapters and protocols that you have installed. Any adapters or 
protocols that you do not use or need should be removed. For example, if you do not have a Modem 
connected to this machine you may not need Dial Up Adapter. You may also have a protocol such as 
IPX/SPX that you do not require. Consult your IT Consultant or Administrator before removing any of 
these. 
 
You will notice that the protocol listing will indicate which protocol is bound to each adapter. e.g. 
NetBEUI>PCI Ethernet DECchip 21041Based Adapter. The PCI Ethernet DECchip 21041Based Adapter 
in this example is the Ethernet adapter used on the Local Area Network. If you require other protocols to 
be bound to your Ethernet adapter, set TCP/IP as the default protocol. 
To install TCP/IP: 
 
Click on Add>Protocols>Add and highlight Microsoft and choose TCP/IP. You may need your 
Windows CD and you will need to restart your machine before the changes take effect. 
 
To set TCP/IP as the default protocol: 
 
Highlight TCP/IP, click on Properties> Advanced and check 'Set as Default Protocol'.  
Note: You may need to restart the machine after making this change. 
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To check that TCP/IP is installed on Windows NT: 
 
Go to Start>Settings>Control Panel>Network. Under Services, check that you have TCP/IP Interface on 
the list. You need to install it from your Windows NT CD. 
 
 Under Protocols check that you have NetBEUI installed. 
 
If you do not have TCP/IP on this list you need to install it from your Windows NT CD 

Other Applications 

There is software you can install that provides certain benefits to your computer system, but may take up 
valuable resources from your computer, resulting in 'timeouts'. You should remove any applications 
running in the background that you do not use or require. You may find that there are a number of 
applications running that you are not aware of because they load automatically, when you start up your 
machine. To find what is running in the background hold Ctrl+Alt+Del to view the Task Manager. Any 
applications that you do not require you should remove by clicking End Task; Do not End Task on 
'Explorer'. An example may be Microsoft FindFast and Office StartUp Assistant (OSA). Remove 
anything from your Start Up folder that you do not need. Removing applications from your Startup folder 
will not remove the application from your computer, but stops it from loading automatically. 
 
To view your Start Up folder Click Start>Settings>Task Bar>Start Menu Programs>Remove. Open the 
StartUp folder and highlight the applications you wish to remove and Click Remove. 
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Power Down and Screen Savers 

Had any of the MYOB machines been left idle when the problem occurred? One of the machines may 
have a CPU or Hard drive 'Power down' feature. You may get a 'Termination code 1250 ... could not send 
message to Bob'. Bob may have been left idle and powered down, causing it to stop responding to the 
network and to MYOB. We strongly recommend that you turn off any Power down features. 
 
To turn off any Power down features go to Start>Settings>Control Panel>Power> and deselect 'When 
powered by AC power', or set Power Scheme settings to 'Never'. You may also need to switch these 
off from the machines BIOS, consult your IT Consultant or Network Administrator about this. 
 
Screen Savers can also cause this problem. We strongly recommend that you also disable any Screen 
Savers. 
To disable Screen Savers, go to Start>Settings>Control Panel>Display> Screen Savers, Select 'None'. 
 

 
 

If required, you may use the power management features of the video driver to ‘blank’ the 
monitor screen after a period, but, DO NOT USE SCREEN SAVERS. 



MYOB – Windows Networking Tips and Tricks 
 

© Dick Hope & Associates  Page 25 

Data file Location 

Is the data file on a server, which is also being used for other applications? If so it may not be able to 
allocate enough resources to MYOB. Perhaps try moving the data file to another, powerful, workstation, 
and run MYOB Peer-to-peer. Because legacy operating systems will fail completely if an application 
crashes, it may be preferable to locate the data file on a workstation which is not running any application 
programs. This concern is eliminated by using only current operating systems, such as Windows 2000. 

Possible Hardware problems 

Problems with network adapter cards, network cables, or the connection between the two could cause 
transmission problems affecting MYOB. There could also be a problem with the software that drives 
these adapters. Make sure you have updated drivers for Network cards and other hardware. You should 
check your Vendor's web site regularly for updated drivers. If you are running on Windows 98 and have 
Realtek drivers, we strongly recommend replacing all Realtek NICs with proven technology, such as 
Linksys. 
 
Make sure that in the Device Manager (Start > Settings > Control Panel > System > Device Manager) that 
the Network adapter is not installed under 'Other Devices'. 
 
You should also consider running Network Diagnostic software to test for transmission errors. 

Low Resources 

Check that each machine has sufficient resources: CPU, RAM, HD space for Virtual memory (keep 5-
10% free min Hard Disk space). Check the amount of free system resources, there should be at least 80% 
free, when MYOB is open. 
 

To check your System Resources go to 
Start>Settings>Control 
Panel>System>Performance. 
 
Ensure that the server, whether running 9X or 
NT, is optimized for File sharing and not 
application operation.  This allocates memory 
and Processor IO to devices like hard drives and 
network cards for maximum Speed and 
Reliability 
 
It is recommended that a minimum of 10% of 
the total capacity of hard disk (or 100 MB, 
whichever is larger) is kept free.  
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To check your computer's hard disk space, go 
to Start>Programs> Windows Explorer, 
highlight the C:\ drive and go to 
File>Properties> General. This will display 
the amount of available disk space. 

 
 
 
 
 
 
 

 

Distance between machines 

If the distance between the machines is too great, messages may not be transmitted properly,.(roughly 
200m per segment for thin Coax/10Base2 and 155m from machine to hub on a twisted pair/10BaseT 
network). You need to ensure that the distance between machines is not too great for the cable to support, 
and keep cables away from fluorescent light fixtures and power lines. 

Slow machines / Fast network card 

If MYOB has to communicate with a slower machine on the network, a backlog of messages could be 
created, therefore causing the TC 1250 timeout. This could also occur if a fast machine has a slow 
network card and a slower machine has a faster card. 

To Check on Workstations: 

Shortcuts 

MYOB is a Peer-to-peer networking program; therefore it needs to be installed on all machines. If you 
use a Shortcut to access MYOB, check the Target to ensure that the application is running locally. 
 
 Right Mouse click onto the shortcut, go to Properties> Shortcut. Where it reads 'Target' it should read: 

C:\Plus11\myobplus.exe M:\data filename.pls  

Where M:\ is the network drive that is mapped to host machines MYOB Folder (where the data file is 
located) and data filename.pls is the name of your data file. 



MYOB – Windows Networking Tips and Tricks 
 

© Dick Hope & Associates  Page 27 

The 'Start in' field needs to read C:\Plus11, to ensure that all the dll files are also run from the local 
machine. 

The above is a guide to eliminating network errors that you may experience; please ensure that you have 
checked all of the settings on all machines using MYOB, before contacting Technical Support. You may 
need to contact your IT or Network administrator for assistance. 

Please log all error messages before calling, including all error numbers and what the users were doing 
when the error occurred. 

Errors in your MYOB data file 
When working in your MYOB data file, you may at some point receive a message that suggests that your 
data file has encountered an error or corruption. The kind of message that you may receive is something 
such as: 

• "MYOB must terminate. Termination Code 12XX usually followed by Error -3000 Important 
Details (XXXX:XX:XX:XX)  

• Index 36 (for Version 2 Users)  
• Index 32 (for Version 1.5 Users_  
• Other Index Errors  
• Test X of 35 during verification  
• Note: If you are getting a message - "MYOB must terminate. A Network error has occurred. 

Termination Code 1250 9998 : XXXX:X:X please refer to our Support Note number 2111 called 
'Termination Code 1250'. 

Error -3000 

If you receive the error message 'An Error -3000 has occurred', MYOB has terminated usually due to a 
corruption caused by an unexpected closure of the program while a record was writing to the data file. If 
you receive a message like this you need to optimize your data file, and then verify to ensure that there 
are no errors in the data file. If this is not successful, you will need to restore from a back up. 

Index 36 and Index 32 

This means that there is a corruption in the Roll Back File, which is created every time you open MYOB. 
If MYOB unexpectedly shut down or crashed while recording a transaction, it can cause transactions to 
be partially recorded, in the Roll Back file. You will need to optimize the data file, and then verify to 
ensure that there are no errors. If this is not successful you will need to restore from a back up. 

Other Index Errors 

If you receive an Index error, it means that one of the Indexes have become corrupted, usually due to a 
crash or abnormal program termination while a record was writing to the data file. If you receive an index 
error you need to optimize your data file, and then verify to ensure that there are no errors in the data file. 
If this is not successful, you will need to restore from a back up. 
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Test x of 35 when verifying data file 

While you are verifying your data file, or 'Checking for errors' during your back up process, and you 
encounter a message Test X of 35, you will need to optimize your data file and then try Verifying again. 
If this is not successful you will need to restore from a back up. 

To Optimize your data file 

To optimize the data file (preferably at the host machine, i.e. where the data file is stored locally): 

For Windows users:  

Close MYOB on all machines. Go to Start>Programs>MYOB >MYOB Optimizer. Click Next at the 
'Welcome' screen, and then Click Find File. Select your data file and click OK, and then Click Next and 
follow the prompts. 

For Mac Users: 

Close MYOB on all machines. Go to your MYOB Folder, and double click on 'Optimization Assistant' 
Click Next at the 'Welcome' screen, and then Click Find File. Select your data file and click OK, and then 
Click Next and follow the prompts. 

While you are optimizing the data file, if you receive a message "Unable to Compact the Database, error 
230:XXX:XXX:X:X, it means that there is someone still logged into the data file, or the Lockfile has not 
been deleted. You will need to delete the lock files yourself. At the host machine go to 
Start>Programs>Windows Explorer and select the folder where your data file is stored. Check for any 
files called Lock0001.flk or Lock0002.flk (it could be up to Lock0010.flk) and delete them if all users are 
logged out of MYOB. 

To Verify your data file 

To Verify the data file, open MYOB and open your data file. Select 'Verify Data' from the File menu. 

If the Optimization or Verification were unsuccessful, you will need to restore from your last back 
up. Once you have restored your back up you should Verify again, to ensure that your back up also does 
not have any corruptions. 

After you have Optimized and Verified your data file, if you are still getting errors and you do not have 
any back ups or your back ups are also corrupted, contact our Technical Support Team for further details. 
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To reduce the possibility of corruptions: 

• Use a UPS on both the Server and Workstations. 
• Make sure that you have Set up MYOB correctly, and have installed the application on all 

machines, and only access the data file from the host machine. If you use a Shortcut to access 
MYOB, check the Target to ensure that the application is running locally:  

o Right Mouse click onto the shortcut, go to Properties> Shortcut. Where it reads 'Target' 
it should read: C:\PlusXX\myobplus.exe. The 'Start in' field needs to read c:\PlusXX to 
ensure that all the dll files are also run from the local machine.  

o Make sure you close MYOB correctly, by going to File>Exit  
• Do not Turn Off the host machines Power while others are working in the data file.  
• Look for any electromagnet interference of cables which can corrupt network messages  

o possibly caused by cables running over flurescent lights in the ceiling  
o network cables running past/over power cables or power sources (particularly industrial 

areas). Try to keep your network cables away from these power sources.  
• Try to reduce the possibility of- power surges and power spikes, by installing Un-interruptible 

Power Supply (UPS), especially if you are in an Industrial area.  
• Problems with network adapter cards, network cables, or the connection between the two could 

cause transmission problems affecting the flow of information to MYOB. There could also be a 
problem with the software that drives these adapters. Make sure you have updated drivers for 
Network cards and other hardware. You should check your Vendor's web site regularly for 
updated drivers. If you are running on Windows 98 and have Realtek drivers, see Support Note 
'2120 Win98 probs and Realtek'. You should also consider running Network Diagnostic 
software to test for transmission errors.  

• Try running a Defrag and Thorough Scandisk to look for any HD surface problems/errors.  
• A fast machine with a slow network card and a slow machine with a fast network card could 

cause network to 'timeout', causing the system to crash or needing to be forced quit. Make sure 
that your machines can support the network cards you have installed.  

We recommend that you back up your data file every day, Checking for Errors (Verifying). This will 
reduce the amount of lost data, in the event of a corruption. 

 


